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Pixels - Dots and Lines Per Inch  

Lines per inch is the resolution in offset printing or 
high volume printing. The more lines that can fit into 
an inch the more detailed the image. Most press runs 
use between 65 to 200 LPI depending on the paper.

65 LPI 175 LPI

The actual PPI reading tells you the resolution of the image at 
100%, whereas the effective ppi tells you the resolution of the image 
when printed at its current scale percentage. Therefore, if you 
place an image at 100%, then both readings should be the same. 
Scale the image down and watch the effective ppi value increase.

Effective- PPI

Printing Resolution LPI DPI

Newspaper                65LPI x2          130 DPI
Magazine                    150 LPI x2        300 DPI
Art Publication           175 LPI x2        350 DPI

Newspaper 130 dpi/65 lpi
Print 300 dpi/150lpi

Photo 600 dpi/ 300lpi

Dots Per Inch/
Lines per Inch

Pixels per inch - PPI

PPI stands for pixels per inch. PPI 
is a measurement of image resolution 
that defines the size an image will 
print. The enlarged photo to the 
left is an example  showing square 
pixels that make up the image. 

Lines per inch

Dots per inch - DPI

Is the measure of dots of ink 
in a one square inch area. The 
number is the same of ppi instead 
of pixels on a monitor, this is what 
we call it once ink hit paper.

Setting up Resolution

PIXELS VS DOTS
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Under profile settings, you will be able to 
select the resolution and color preferences. 
For quality photos, remember to choose a 
resolution of  300 dpi or higher for most 
print except newspaper.

Once it has scanned, you’ll find a 
dashed black line framing your photo, 
indicating the adjustable cropping 
area. Use your cursor to grab any 
corner, and then drag your mouse to 
adjust the size of  the cropping area to 
fit the photo. Only select the area you 
would like to scan.

 What size reproduction is the largest 
dimension you would want to use for your 
image. 

First, place the photograph you would like 
to scan into the lower right corner of  the 
scanner bed. Follow the orientation indi-
cated by the icons on the template.

Click on file - Aquire

Select your destination printer
You now have a high-quality print of  
your scanned original. 

How to Scan an image.

: save your photos

300

9.01 mb

2099

Height x Width = Resolution
8in. x 8in. = 150 lpi x 2 = 300

8in x 8in @ 300 ppi =15.70

photo  by Rick McCawley

1500

200

9.01 MB

SCANNER  WINDOW

5 by 7 photo for print 150 
Line Per Inch x 2 = 300 Dots 

Per Inch.  (9.0) mega bites

7 inch by 5 inch photo 
resolution 300 pixels 

megabites 9.01
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175 LPI

Scanning and Resolution

Select - Source

Click Scan.

SCANNING
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Image Adjustment
Why is image adjustment important?

To simulate the color, tones, highlights, and shadows of an 
RGB image in a CMYK image, and in 4 color printing, adjust-
ing an image with Curves, Levels, and the Unsharp Mask Filter 
along with color correction, must be used. Image adjustments 
compensate for dot gain and color casts or unwanted colors in 
an image. These same strategies can be applied to each color 
separation individually in order to fi lter out unwanted color 
casts or stray color that will end up on a plate or negative.

Dot gAIN WILL DARkeN the Photo AN MAke
It APPeAR Less shARP As INk seePs INto 
the PAPeR.

Levels
Neutralizes color casts and compensates for dot gain by 
lightening the image

1. Image>Adjustments>Levels
2. Set the lightest color by selecting the white eyedropper 

and clicking on the lightest part of the image
3. Set the darkest color by selecting the black eyedropper 

and clicking on the darkest part of the image
4. Overcompensate for dot gain by dragging the middle 

slider and dragging to the left, lightening it

Unsharp Mask
Detects contrast along edges and will sharpen the 
photo to compensate for dot gain

1. Filter>Sharpen>Unsharp Mask
2. Set Amount: 120, Radius: 1, Threshold: 3, for best

settings
3. Review differences by checking/unchecking preview box

oN 
sCReeN

oN 
PAPeR

Pixels

Ink

RgB

CMyk
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What is Color Correction?

Color correction is the adjustment of the relationship between 
process colors to achieve desirable colors. This is necessary 
whenever converting from RGB to CMYK, since a wide 
range of colors seen on-screen, which can only be mimicked 
in CMYK, are lost during the conversion. There is more color 
control in RGB (most fi lters work in RGB, rather than CMYK), 
so any correction should be done while working in RGB.

Knowing where the file will be printed before 
starting any design is highly important, since it 
will affect what colors you can and cannot use.

Converting to CMYK loses a 
wide ranges of colors. Be sure 
to convert only for commercial 
printing, since many home printers 
can successfully reproduce some 
RGB colors lost in CMYK.

You can and should change your 
color settings for all Adobe products 
within the creative suite color 
settings box of the Adobe Bridge, 
which is under the edit menu.
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Color settings:

1. Once you have the profi le needed 
for your printer, or if you know what 
workspace you want to work in, choose 
Color Settings under the Edit menu

2. Choose the Work Spaces and 
Color Management Policies that 
will conform to your printer

3. Save in order to use them again or to 
apply them to the rest of the creative suite

4. A preview refl ecting these settings is 
found under the View menu as Proof Colors

Converting RgB>CMyk:

1. Adjust Color Settings and Adjust 
the image prior to conversion

2. Choose Image>Mode>CMYK Color
3. Click OK if you are content 

with your current color settings

!
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Duotones/Monotones/Tritones/Quadtones
What are Duotones?
Black and white images reproduced using two halftone
negatives, which represent the tones of the image.
Monotones use one halftone negative, tritones three, and so on.

File Types

how to Create Duotones:
1.Convert to Grayscale
2.Image>Mode>Duotone
3.Choose colors
4.Choose curves
5.Choose overprint colors

tIff Tagged Image File Format. Tiff has a loss-less compression 
known as LZW that saves approximately half of a fi les size 
without loss of quality. Alpha channels are saved also.

ePs Encapsulated Postscript, used in pre-press for color  
separated images. Contains calibration compensation 
information, and supports both raster and vector data.

PsD Photo Shop Document, the native Photoshop fi le format it 
uses loss-less compression and retains layers, effects, type, and 
alpha channels, as editable upon reopening.

JPg Joint Photographic Experts Group. This is the most 
popular image format on the web because of its great fi le 
size compression as much as 100:1. It is a lossy compression 
method (you lose quality).

Best foR PRINt

ILLUstRAtoR,
CLIPPINg PAths,
AND DUotoNes

stANDARD,
Not UseD foR 

ALL PRINt

UseD foR the WeB

quadtonetritoneDuotoneMonotone

PHOTOSHOP PRE-PRESS
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Color Separation
What is Color separation?
When processing an image for print, images are broken into four halftone 
negatives or plates (depending what type of printer used). Light from the 
image passes though red, green, or blue fi lters to create either cyan, ma-
genta, or yellow plates or negatives, respectively, abbreviated CMY.
Because these three colors don’t create proper black, a separate negative or 
plate is made for black, abbreviated K.

CMYK

Spot Colors + UV

Previews of the color plates are visible in Photoshop 
under the Channels panel, where you choose to edit 
these for better reproduction.

Commercial printers may Request color separations in 
order confirm for the client how each plate will look.

This method is excellent for screen printing and other 
types of specialty printing and finishing like UV 
coating.

how to Create:
1.Create a selection
2.Go to Channels panel and create a new channel
3.Name the channel in order to specify to the printer what this extra
negative or plate will be for, which is especially useful if you are
using more than one spot color

how to Print separations:
1.Once an image has been color corrected and is ready, click 
File>Print
2.Navigate to Color Management
3.Choose Separations under the Color Management drop-down 
box
4.Click Print

kyMC

kyMC

R g B

kyMC

P

FILTERS

PLATES

COLOR SEPERATIONS
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Clipping Path

Conversion to target Document

Popular Uses for Clipping 
A clipping path functions as a two dimensional ‘green 

screen.’ The path can be placed on a transparency or 
alternative background. Clipping path usually have 
anti-aliased edges, depending on the software.

Refer to ‘Pen Tool’ in Illustration

What is a Clipping Path?
A clipping path is a vector path or outline 

that acts as an x-acto knife, removing part of 
an image, in favor of a transparency,‘knocking’ 
out other portions of the original image.

finding the tools 
to make a clipping mask.
The tools needed for creating a clipping path are the ‘selection’, 

or ‘pen’ tool. Creating contours with the pen tool is detailed in the 
Illustrator manual and when creating a path, fl atness determines, 
how closely the path adheres to the contours you’ve created

Creating the path1

  
Once saved as an EPS, the path can simply be 

dragged into the target document. The ‘File-Place- 
Option is also effective in most programs.

2

3

4

 Saving the path

In ‘Path Options’ create a new “Clipping Path”; this 
can later be duplicated or saved. The ‘Flatness’ of the 
path is also controlled when you create the path.

Saving the path as an EPS, allows it to be 
embedded or placed within Illustrator, 

Photoshop, PDFs, or any image editing software 
without the default ‘white space’ of the background, 
that you would receive otherwise placing the image.

Exporting the path as Encapsulated Postscript.

Dragging or placing path 
within secondary document

CLIPPING PATH
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Pre-Press for Images: Six Essential Steps

5

6

Resolution

Color Correction

Unsharp Mask

Mode Conversion

Save as EPS or TIFF

Import into Page Layout

First take into account any enlargement of the 
original artwork. Two lines line screen equals effective 
DPI (Dots per Inch) or PPI (Pixels per Inch)

Example 85 lpi (Lines per Inch) which is 
used in Newspaper print 85x2=170dpi

Examples
65-85 lpi- Newspapers (high dotgain 

15%-30%) absorbs ink
85-150 lpi- Magazine (dot gain 5-8%)
150-300 lpi-Fine Art publications (better quality 

coated paper allows for more detail-dot gain 2-7%

                                        Image Size
-Uncheck resample image- (Resample means to add 

dots or throw them away)Adding dots that did not exist 
in the original will degrade the quality of the image 
Ensure the photo does not need the higher resolution

Entails setting Levels point values.
This step is adjusted before converting 

to CMYK from RGB. 

Makes picture sharper than on screen for printing
Filter Menu-Sharpen
Unsharp Mask- This detects contrast along edges 

that will sharpen photo to compensate for dot gain

Amount-120
Radius-1
Threshold -3

Convert from RGB to CMYK
Ensure Photoshop color settings are set to U.S. 

Pre-Press before making the conversion.

EPS’s are used for clipping paths and illustrations only. 
Saving as TIFF format is used for everything else.

Ensure the image/fi le is fl attened before saving.
LZW-(This is fi le compression that is loss-less; 

It will save about half the fi le size

Package the fi le and produce a PDF of low 
(for revision) and high (fi ne art) quality.

                                        Image Size

Unsharp Mask

to CMYK from RGB. 

CLIPPING PATH
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Adobe Illustrator
What’s so cool about Illustrator?
Illustrator is a vector drawing program where 

fi gures are created with points that create lines and 
curves.  Also type can be easily manipulated
Unlike bitmap images that stores information 

in a grid of dots, Illustrator uses mathematical 
equations to draw out the shapes. This makes vector graphics scalable 
without the loss of resolution, lines are crisp and sharp at any sizes, 
illustrations print at high resolution, and produce  smaller fi le sizes.

Most common uses for Illustrator:
Logo design, Illustrations, Cartoon drawing, Packaging
design, Information graphics, Maps, Charts, and Diagrams

Why is this important? 
A Mask is a window to something larger. If the image is too large it will increase your fi le 
size tremendously if embedded and also it may exceed outside the art board. When a fi le 
gets sent to print they have to process all the images that are outside the art board even 
though it doesn’t print. Also increases fi le size. We’re pros and save headaches. 

go fix it 
Select the object or image > Menu Bar: Edit Original > Crop in Photoshop using the 
crop tool. 

Preparing Illustrator files like a Pro
Your Illusrator pre-press checklist to help you avoid embarassing situations

Crop Masks to Smallest Possible Size

Why is this important? 
Each point on a line is a Postscript stack that needs to be processed before the RIP can 
proceed to process the line. Too many points can cause the RIP to crash or objects to fall 
off the art board. So a good habit when creating vector objects is to use the fewest points 
possible. 

go fix it 
Select the object that you need to simplify > Object > Paths > Simplify

Points: The Less the Better

Why is this important? 
A pantone color creates an extra plate on the printing press. A gradient containg two 
separate spot colors will not reproduce nicely. Neither will a gradient between a spot color 
and a cmyk color.  Effective gradients can be achived by using cmyk colors. 

go fix it 
Select the Object that needs the gradient corrected > Open the Gradient Palette 
(windows > Gradient) > Double click on the color and change it to corrected color. 

Color Correct Gradients

CMYK

CMYK

CMYK PANTONE

PANTONE PANTONE

Why is this important? 
If your fi le is too complicated, fl atten it. What this does is simplify all the complicated 
elements on your art board such as: masks, transparencies, gradients, large images, and 
fl attens it into one solid layer. It may create some slices but your overall job will print the 
same.

go fix it 
WARNING! Before you do this save a copy of the original and name this fi le something 
else. Go to Edit > Transparency Flattener Preset> Follow the instructions from there.

Flatten if Complicated

PRE-PRESS ILLUSTRATOR
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Why is this important? 
Ink or no ink that’s how the printer thinks! Transparencies don’t really exist. The printer 
either squirts ink or no ink. SO a transparency actually translates in either a fully fi lled 
halftone dot or a percentage of it. So instead of lowering the opacity or the transparency 
of an object in order to get a new “cooler” color try using a tint of the same color. 

go fix it 
Select the Object with the transparency > Change the transparency back to 100%: Win-
dow > Transparency. Now that your object is totally opaque, select it again and go to 
windows > color guide> and select a tint of the original color. 

Transperancies to Tints

Why is this important? 
So that the typeface you chose does not get changed when sent to another computer.  If 
your printer doesn’t have the font you chose it will substitute it for something else and alter 
the appearance and alignment of your doc. Before you convert your text to outline, save 
your document and create another name for the same document. You want to do this so 
that you can always go back and make changes. Once you go Outline, you can’t go back! 

go fix it 
Select all the type with the selection tool > Type > Create Outlines. Voila! It’s been done. 
Illustrator just turned your live editable text into shapes with points.

Turn Live Text to Outline

Why is this important? 
Grouping objects in an illustration can cause the RIP to crash. Post Script is organized 
into a series of stacks. Each object comes with a stack of code. When two objects get 
grouped an additional stack is produced. After you make the correction nothing will 
vappear altered, but the amount of code that is sent to the RIP is more than necessary. So 
before sending your job to the printer, ungroup everything. 

go fix it 
Select all the objects and ungroup each of them by either going to edit > Ungroup. Or 
Right clicking and selecting ungroup. 

Ungroup If Possible

Why is this important? 
If you send your Illustrator fi le with linked, placed or smart objects you have to include all 
those separate items in a folder along with the AI fi le.  If you don’t, when you send your 
fi nal art design to the printers, your fi le will open but all your linked, placed, and smart 
objects will not be there. Just because you see it on your art board doesn’t mean it’s really 
there.  To ensure this doesn’t happen package your work.

go fix it 
Select the linked object. On the top menu select “embed”. This makes your object 
offi cially apart of your fi le. If the object is too large, you have to create a folder and place 
your AI doc along with all the linked, placed or smart objects.  Place all the fonts you used 
as well.  Once you have everything included in your folder you’ve created your package. 

Make Sure What’s There is There: Linked, Placed, and Smart Objects

Object appears 
to be on art board 
but it’s really linked

PRE-PRESS ILLUSTRATOR
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Process Color trapping:
Use Common Process colors to 
close gaps can prevent knockouts
and overprints. 

too Close trapping :
Avoid touching or almost 
touching other colors to 
avoid knockout on objects. 

Spreads & Choke

  Need to Trap when there is overprinted objects ( also call surprint-
ing ). When objects are printed over other objects it mix the ink & 
result in unexpected colors.

Black outlines:
Use black outlines around
obje cts and on black text 
to avoid overprint & knockouts.

Spreads 

Knockouts 

Overprint 

In most cases, when 2 objects of different colors overlap they 
knockout, they won’t print on top of each other. In reality 
the color are printed side by side so there is a chance that the 
colors can get out of register. They may require trapping.

A spread is when a lighter object overlaps a darker 
background and seems to spread into the background.

Overprint
Black

What is Trapping 
Trapping is a method of correction in print. When objects 

& colors don’t align properly there can be a gap, (knockout). 
This is called misregistration. Trapping compensates for 
the  possibility of misregistration on the printing press 
by making the gap less noticeable, even invisible.

Knockouts & Overprint

How to Avoid Trapping

Choke 
  A choke uses a lighter background to overlap a darker 
object that falls within the background and seems to 
squeeze or reduce the object.

TRAPPING
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how do you trap in Illustrator?

Select the two images you want to trap at the same time.

From the EFFECT menu, select PATHFINDER, and 
click the option TRAP. In the Pathfi nder dialog box you 
can choose the thickness, height/width, and tint reduction 
among other trapping options. Then, click OK.

Then Pathfi nder will compare the two images, and 
select the lighter color to overlap the darker one.

Best way to trap in Photoshop:
 
In order to use Photoshop Trap options you must open your images
in CMYK mode.

Select the area that could be a misregistration.

From the IMAGE  menu, select TRAP dialog box enter trap
width, and click OK.

Photoshop automatically creates traps to compensate any possible
gap within your selection.
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Adobe Preflight
What’s so cool about Preflighting?

The term preflight check originates from the aviation industry where it is a standard procedure 
for pilots to go over a checklist before lift-off. Preflight checks (preflighting) for print documents 
have a similar idea in mind. They run through all the files you used in the document to see if 
they’re missing, changed or anything else that might have happened to the file. The Preflight Check 
dialog screen uses categorized sections to check your documents on errors and missing files. 

ADOBE PREFLIGHT

Photoshop Pre-Press for Images

Resolution: You must take into account 
the enlargement of original art work 2x 
line screen= the correct PPI or DPI

Color Correction: Make before converting to 
CMYK, there is more color control in RGB.

Unsharp-Mask: Needed for dot gain, make 
picture sharper than on screen for printing.

Mode Conversion: RGB to CMYK. 
Make sure Photoshop color settings 
are set to U.S. Pre-Press defaults 
before making the conversion.

Save as EPS or TIFF

Import into page layout program.

1

2

3

4

5

6

Illustrator Pre-Press for Images
Note: Before preparing document for press, 

make sure to keep a backup .ai copy. 

Convert Pantone to CMYK. Edit> 
Edit Colors> Convert to CMYK

Convert color mode to CMYK. File> 
Document Color Mode> CMYK

Outline all text in document.
Flatten transperencies which 
include opacity and gradients.

Save as EPS.

Import into page layout program.

1

2

3

4

5

6



 – PRODUCTION

14www.GoDesignNow.com

INDESIGN PREFLIGHT

InDesign Pre -Flight

Problems with  your document

You are about to send you project out to your local 

printshop but wait, before you do that you need to 

check to make sure you dont have any errors.

opening a document

You ever open up a document and it says that you are 

missing links? You probably think nothing of it and just 

clicked ok. This is a big mistake and we will tell you 

why.

Checking your Links Panel

Your links panel shows you where you are having  

problems with  missing and/or broken links to a text 

box, picture, or fi le. The links info panel shows you all 

the data contained  within the specifi ed fi le. Such as...

Name – name of the linked fi le.
Format – such as jpeg, tiff, illustrator, photoshop fi le, etc...
Page – what page the error is on.
Color Space – such as RGB, sRGB, CMYK.
Status – such as if the fi le is missing 
or unlinked in some way.
Size – the size of the fi le.
ICC Profi le – defi nes the amount of saturation 
of colors available in the color space; i.e. the 
bluest blue your printer can produce.
Actual PPI – the resolution of the image at 100% size.
Effective PPI – the resolution of the image 
at the size it’s been scaled to in InDesign. 
For Example: a 300 ppi image, if scaled 50% in 
InDesign, is actually 600 ppi when reduced to that size.

Getting Started
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Pre-Press Checklist
spelling

A fi nal spell check was done and 
there are no misspelled words.

Color
Make sure the only color modes in 
the fi le are those that you want.

Spot colors are defi ned as a mixture of 
colors and process colors are defi ned 
as a separate as 4-color process.

Imported images are built in the correct 
color space to be separated as required.

 

Images
All images are the proper resolution 
for the required press linescreen.
All imported images have the correct 
corresponding colors to be printed.
All imported images are built in the correct color 
space for separations, e.g. CMYK vs. RGB.
All imported images are an appropriate format 
for printing, e.g. tiff or eps vs. gif or jpeg.

Any low-resolution FPO images have been 
replaced with their high-   resolution counterpart.

Bleed
A 1/8” bleed (or amount desired by printer) 
has been built into the document if necessary.

 the Preflight Panel

This panel is used to not only make layout 
corrections, but to actually have the program 
make them for you. This panel will show you 
everything that you may be looking out for 
before you send the fi les to your printshop.
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INDESIGN PREFLIGHT
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Pre-Press Checklist (cont.)

fonts/typography
Make sure that you defi ne the types of fonts 
that you want to have in your documents.

Fonts are defi ned in document using the actual 
font, not QuarkXpress’ fake bold or italic.

You have both the printer and screen fonts available 
for all typefaces used to send to the printer.

Document
To insure pages are oriented in 
the correct way and size.

Moniter how many pages that you wish 
to incorporate in your document.

The bleed and slug areas are discarded when 
the document is trimmed to its fi nal page 
size. Objects outside the bleed or slug area 
(whichever extends farthest) are not printed. 

Completing your document

If you have any errors, missing images for example, 

Indesign will display a red circle indicating there is an 

error and how many errors are in your document. 

After everything is done correctly according to how 

you have setup your Prefl ight Panel and profi les you 

should have no errors in your document. The Red 

Circle should now display green.

Collect for output
Laser prints of separations have been 
printed to correspond with composites.

Composite fi le to be marked with notes for the vendor.

A disk directory has been printed, and 
fi le(s) to be output are highlighted.

Package document to make sure all fi les are together 
to make sure all images, fonts and graphics are 
arranged, in a folder to be sent to the vendor.
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PDF Workflow

High-resolution output file (CMYK 
or RGB workflow) Compression 
identical to the Press preset. 
Doesn’t allow security settings. 
Transparency must be flattened.

Output for prepress devices 
such as an image setter, plate 
setter, or digital press. Doesn’t 
convert color spaces. File size 
compression downsampling. 
Embedded fonts.

Output for desktop and proofers. 
File size compression and 
downsampling. Embedded fonts.

High-resolution CMYK output file. 
Compression identical to the Press 
preset. RGB colors converted to CMYK. 
Spot colors supported. Transparency 
must be flattened.

Output for desktop and proofers. File 
size compression and downsampling. 
Embedded fonts. 
Live transparency and layers supported. 

Output for web, intranet, or e-mail 
system. Small document. File size 
compression and downsampling to 
monitor resolution.

Refers to decreasing the number of pixels in an image. To 
downsample an image, choose an interpolation method and 
enter the desired resolution (in pixels per inch)

Type of compression that is used to reduce 
the file size.

PDF WORKFLOW

Adobe PDF files are used for high-resolution printing. 

May reduce file size by exporting only image data 
that falls within the visible portion of the frame.

High Quality Print

PDF/X-3:2002

Press Quality

PDF/X-1a:2001

PDF/X-4:2008

Smallest File Size

Controls how colors 
and PDF/X output intent 
profiles are saved in the 
PDF file. Specifies how to represent color information in the Adobe PDF file. All 

spot color information is preserved during color conversion; only the 
process color equivalents convert to the designated color space.

Determines whether a color profile is included in the file. The options 
vary, depending on the setting in the Color Conversion menu, 
whether one of the PDF/X standards is selected, and whether color 
management is on or off.

B

C

D

E

A

B
C

D

E
A

Determines the amount of compression that is applied. For JPEG or JPEG 
2000, you can choose Minimum, Low, Medium, or Maximum quality. 
For ZIP, only 8-bit is available.

Applies flattened 
compression to all 
text and line art in the 
document, without loss of 
detail or quality.
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 THE PRINTING PRESS

The Printing Press
In the next chapter, you will learn in detail all about the traditional process printing 
method. But first, let’s get familiar with the three main types of press available today:

PROS:
The most accurate proofing system.

CONS:
Create a lot of paper waste.
The longest and most expensive.

Designer

Press

Plate

Film

Image Setter

Electronic Imposing

Press

Plate

PROS:
Save time and money 
eliminating film step.

CONS:
Can’t create color key proofs.

CONS:
More cost per piece.
Limited Medium.

PROS:
The most advance, cheapest, and fastest 
printing system.
Everything is done electronically. 
Very little labour involved.
Use of Pantone and 4 colors.
Simple proofing system. 
Less paper waste is created.

Traditional Direct to Plate Digital

Designer Designer

Electronic Imposing
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Colors and Logos

Color Meanings

Energy, warmth, joy, intellect, 
caution, cheerfulness, friendliness.

Danger, passion, daring, romance, 
style, excitement, urgency, energetic.

Energy, change, movement, 
vitality, sense of welcoming.

Life, growth, environment, healing, 
money, safety, relaxation, freshness, 
new beginning, harmony.

Peace, stability, calmness, 
confidence, tranquility, sincerity, 
affection, integrity, responsibility.

Royalty, luxury, dignity, spirituality, 
passion, vision, magic, creative, 
romance, inspiration.

Dependability, earthiness, 
dull feeling of warmth, 
wholesomeness, friendliness.

Sophistication, power, mystery, 
formality, evil, death, elegance.

Hyper, indescribable, Mercurial, 
conflicted, disorganized, wild, 
high energy, pandemonium.

COLOR & LOGOS
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Types of Spot Colors

The Pantone Matching System, or PMS, is the internationally 
recognized standardized color-matching system that is privately 
owned by the Pantone Corporation. Because individual perceptions 
of the color spectrum vary widely, the Pantone system is used 
throughout color-critical industries as the defi nitive source for 
accurate color communication, ensuring that colors are 
consistent across projects, designers, printers and companies.

Toyo is a common spot color system in Japan and in 
offset printing, a spot color is any color generated by an 
ink (pure or mixed) that is printed using a single run.

Toyo inks come in 1050 colors while pantone    inks 
provide 1114 standard colors, and even their ‘hexachrome’ 
system (CMYK + hexachrome orange + hexachrome 
green), while supposedly “meeting or exceeding the 
RGB gamut”, has only about 2000 numbered colors: 

The HKS is a colour system which contains 120 
spot colours and 3250 tones for coated and uncoated 
paper. HKS is an abbreviation of three German colour 
manufacturers: Hostmann-Steinberg Druckfarben, Kast 
+ Ehinger Druckfarben, and H. Schmincke & Co.

 
HKS colours, similar to Pantone colours, can be used 

in any kind of print publication to produce predictable 
colours. As in the Pantone colour system, there are HKS 
colours that cannot be reproduced using the CMYK 
colour space, like bright orange or certain tones of blue.

TOYO

HKS

PANTONE

SPOT COLOR



PRODUCTION –

21 www.GoDesignNow.com

TYPES OF PRESSES

The Printing Press
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Letterpress
is relief printing of text and image using a press with a 

“type-high bed” printing press and movable type, in which 
a reversed, raised surface is inked and then pressed into a 
sheet of paper to obtain a positive right-reading image.

Lithography
is a method for printing using a stone 
(lithographic limestone) or a metal plate with a 
completely smooth surface.

Intaglio
is a family of printmaking techniques 
in which the image is incised into a 
surface, known as the matrix or plate.

Flexography
is a form of printing process which utilizes a 
flexible relief plate.

Screen printing
Is a printing technique that uses a woven 
mesh to support an ink-blocking stencil.

Die cut
is a striking way to make unique die cuts using digital 
photographs, stock images or simple shapes and patterns. 
Can be used in many projects from decorating scrapbooks 
and creating homemade cards to decorating paper dolls 
and making game pieces.

Foil
typically a commercial print process, is the application of 
pigment or metallic foil, often gold or silver , but can also 
be various patterns or what is known as pastel foil which is 
a flat opaque color or white special film-backed material, 
to paper where a heated die is stamped onto the foil, 
making it adhere to the surface leaving the design of the 
die on the paper.

Vinyl
Used for printing banners and billboards.
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MAKING PAPER

How paper is made
Papermaking process 

There are two major mechanical pulps, thermo mechanical 
pulp (TMP) and groundwood pulp (GW). In the TMP process, 
wood is chipped and then fed into large steam-heated refiners 
where the chips are squeezed and made into fibres between two 
steel discs. In the groundwood process, debarked logs are fed into 
grinders where they are pressed against rotating stones and made 
into fibres. Mechanical pulping does not remove the lignin, so 
the yield is very high, >95%, but also causes paper made from 
this pulp to yellow and become brittle over time. Mechanical 
pulps have rather short fibre lengths and produce weak paper. 
Although large amounts of electrical energy are required to 
produce mechanical pulp, it costs less than chemical pulp.

Mechanical Pulping

Finishing Paper Process

Why is this important? 
Recycled papers can be made from 100% recycled materials 

or blended with virgin pulp. They are (generally) not as 
strong nor as bright as papers made from virgin pulp.

Paper recycling processes can use either chemical or mechanical 
pulp. By mixing with water and applying mechanical action the 
hydrogen bonds in the paper can be broken and fibres separated 
again. Most recycled paper contains a proportion of virgin fibre 
in the interests of quality. Generally deinked pulp is of the same 
quality or lower than the collected paper it was made from.

Deinked Pulp

Paper is produced by pressing together moist fibers, typically cellulose pulp 
derived from wood, rags or grasses, and drying them into flexible sheets. Paper is a 
versatile material with many uses the most common is for writing and printing.

Producing paper
The pulp is feed to a paper machine where 

it is formed as a paper web and the water is 
removed from it by pressing and drying.

Pressing the sheet removes the water by force. Once the 
water is forced from the sheet, felt (not to be confused with 
the traditional felt) is used to collect the water. When making 
paper by hand, a blotter sheet is used. Drying involves using 
air and or heat to remove water from the paper sheet.

The paper may then undergo sizing to alter its physical 
properties for use in various applications. Paper at this point 
is uncoated. Coated paper has a thin layer of material such as 
calcium carbonate or china clay applied to one or both sides 
in order to create a surface more suitable for high-resolution 
halftone screens. (Uncoated papers are rarely suitable for 
screens above 150 lpi.) Coated or uncoated papers may 
have their surfaces polished by calendering. Coated papers 
are divided into matte, semi-matte or silk, and gloss. Gloss 
papers give the highest optical density in the printed image.

Bleacher

Additi
ve

s

-Washer

-Chipper

-Sawmill 
Debarker

-Press

-Ink Press

-Dry Press

-Processed Paper
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-The microscopic structure of paper under ultraviolet illumination. 

The purpose of a chemical pulping process is to break down the 
chemical structure of lignin and render it soluble in the cooking liquor, 
so that it may be washed from the cellulose fibers. The pulp can also be 
bleached to produce white paper for printing, painting and writing. Paper 
made from chemical pulps are also known as wood-free papers.

Chemical Pulping 
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CHOOSING PAPER

What is your final product? It can be a book, poster, flyer, business card, etc.
How long would you like the durability of the product to last? A book that will be read throughout 
the years should definitely be planned for a longer durability than a one day flyer.
What feeling do you want your product to give the receiver? 
Should it be fancy? Cheap? Solid? Traditional?
What kind of material will the product be handling? Will it be 
spread after spread with large photos? Or a textbook?
Will the piece be mailed, mass mailed or handed out personally to selected prospects?

Pa
ge

 d
es

ig
ne

d 
by

 T
ha

is
 A

lm
ei

da

1

2

3

4

5

Choosing the Right Paper
Why is important to know about paper?
Choosing the right paper for a design is crucial. Different papers take ink differently. 

Paper can affect the legibility of type, the texture, tone, and personality of a piece. 
Choosing paper is more complex than just picking the most 

expensive sheet and keeping your fingers crossed.
In fact, you shouldn’t think about choosing paper based on the highest 

quality available, or the highest quality you can afford. Rather, you should 
figure out the most appropriate quality paper for your needs because most 
appropriate equals best. The point is - no one sheet fits every project.

Here it is a guide to help you choose the appropriate paper for your design.  

Wove or Smooth - A smooth uncoated surface.	

Laid - A paper that is manufactured with textured lines 
on its surface. This finish is used mostly for business sta-
tionery elements, like letterhead, envelopes and business 
cards.

Linen - Similar to a laid finish, this paper has textured 
lines on the surface of the sheet, but they are finer and more 
regular than those that appear on a laid finish stock. This 
paper is also used frequently for business stationery

Laser - A paper that is guaranteed to be compatible with 
laser printers.

Coated - A paper with a waxy finish (shiny or matte).

Uncoated - A paper with an untreated surface that is 
dull and unreflective.	

Coated One Side (C1S) - A cover stock that has a coat-
ing on one side and is dull on the reverse side.

Coated Two Sides (C2S) - A cover stock that has a coat-
ing on both sides.

Ask Yourself Some Questions

After you’ve answered these questions you can take a look at 
the different elements that can be crucial for your paper choice: 
finish, weight, thickness, opacity, brightness, and color. 

Finish

It’s recommended that in the beginning of your project, 
you take your time and think about some issues:

The finish of a paper is its surface texture. Consider the look you 
want to achieve, and choose a finish that fits your needs:
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CHOOSING PAPER

Thickness is referred to as caliper and is measured in 
mils or thousandths of a inch. In general, the more a 
sheet of paper weights, the thicker and/or stiffer it is. 

Paper caliper determines thickness of the printed piece, 
an important consideration with products such as books, 
catalogs and directories. The chart on the left represents 
books made from 248 sheets (496 pages) of typical 60# papers.

When imagining the books represented in this 
chart, keep in mind that all five have identical heights. 
Although some are thinner than others, all contains 
496 pages of paper with the same basis weight. 

Color is especially important as it affects the color reproduction of lighter tints. Paper colors 
vary with advertising fads from cool to warm shades. Type is more easily read against a soft 
(yellowish) white, while process color reproduce most accurately on neutral white paper.  

The brightness measures the percentage of a wavelength of blue light that a sheet 
reflects. It’s typically expressed on a scale of 1 to 100 with 100 being the brightest. 
Most papers reflect 60-90% of light. The brightness of a paper can effect readability, 
the perception of ink color and the contrast between light and dark hues.

Caliper/ Thickness

It can be measured in a couple of different ways depending 
on the country you’re working in. Two of the most used 
are grams per square metre and the pound weight of a 
ream (500 sheets) in the basic size for that grade. In the 
US it is measured in pounds. For different types of paper 
the size of the basis ream may differ resulting in vastly 
different weights. For example, basis 70 means that 500 
sheets 25 x 38 inches of  book paper weigh 70 pounds. 
This is equivalent to 104 g/m2 in the metric system.

A paper’s opacity is determined by its weight, ingredients 
and absorbency. A paper’s opacity determines how much 
printing will show through on the reverse side of a sheet. 
Opacity is expressed in terms of it’s percentage of reflection. 
Complete opacity is 100% and complete transparency is 0%.

Weight

Opacity

Color

Brightness

Bond
(lbs)

Offset
(lbs)

Cover
(lbs)

Tag
(lbs)

Index
(lbs)

Metric
(g/m2)

29 73 40 62 60 109.11
31 81 43 73 66 118.42
35 90 48 80 74 131.68
36 90 50 82 75 135.45
39 100 54 91 81 148.02
40 100 56 93 83 150.5
43 110 60 100 90 161.78
44 110 61 102 92 165.55
47 120 65 108 97 176.83
53 135 74 122 110 199.41
54 137 75 125 113 203.1
58 146 80 134 120 218.22
65 165 90 150 135 244.56

EQUIVALENT WEIGHTS
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Specialty Papers

Translucent is a thin paper 
that has some clarity allowing 
any content placed beneath it to 
be viewed (semi-transparent). 

There is a vast array of paper available for the  
graphic designer. Each project you work on will  
required a specific type of paper. The most used papers 
have a smooth finish and come in a full range of white 
shades. Specialty papers add elements of texture 
and color and help set the mood for your project. 

Metallic papers are coated with 
a thin film containing metal or a thin 
film of plastic whose color and gloss 
simulate metal. It comes in a range of 
weights  and colors.   

Cover stocks are heavy in weight, rigid and not eas-
ily folded. These papers are generally used for publica-
tion covers, business cards, greeting cards, folders, and 
postcards. They can have coated or uncoated finishes. 

Offset and Bond papers are thin and smooth. 
Often used for publication interior sheets,  
brochures & flyers, and letterheads and  
envelopes.  

Linen paper has a texture created by emboss-
ing  that looks like linen cloth. Felt papers are manu-
factured using fabric blankets pressed onto the wet 
paper. Laid paper has a ribbed texture. These papers 
are heavier than most Offset and Bond papers. Of-
ten used in portfolio presentations for businesses.

Metals used for metallic 
papers are often highly toxic 
and cannot be recycled, 
there are environmentally 
responsible metallics available 
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Recyclable only means that a material 
or product can be recycled. It does not 
necessarily contain recycled material.

Recycled and Alternative Papers

Paper made from fibers other than trees can be 
environmentally friendly and be visually interesting. 

Alternative papers are made from Hemp, Rice, Coffee, 
Coconut, Sugar Cane, Banana, Recycled rags.

Paper accounts for an average of  
40% of  landfill volume. 

Recycling paper and purchasing  
recycled paper reduces the amount of 
waste we send to landfills and incinerators. 
When compared with 100% virgin fiber 
copy paper, 100% recycled copy paper is 
estimated to reduce solid waste by 49%.

Forest Stewardship Council (FSC), 
is a non-profit organization set up 
to encourage the use of sustainable 
practices in forestry worldwide.

Totally chlorine free applies to virgin 
fiber papers   that are unbleached or 
processed with a sequence that includes 
no chlorine or chlorine derivatives.

The Green-e mark is offered by the 
non-profit Center for Resource Solutions 
to indicate companies that purchase or 
generate certified renewable energy.        

To qualify for( Post Consumer Waste) 
certification, the paper must contain 
a defined percentage of waste paper 
reclaimed after consumer use.

Green seal certifies environmentally 
responsible practices among 
manufacturers or paper products, from 
fine printing papers to coffee filters.

Symbols to look for: 

Recycled rag paper

Hemp paper Sugar Cane paper

!

CHOOSING PAPER
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Why is this important? 
As you know, printing is a costly and work-intensive process. It 
is crucial that you follow these simple steps to make sure your 
files are properly setup for the printer, as making changes at this 
stage of the design process can become very expensive and time-
consuming.

Setup:
WARNING! Before you do this save a copy of the original and 
name this file something else. Make sure your files are packaged 
and no editing must still be done.

Print Proof
A general term for a variety of options for seeing what your file 
will look like when printed is a proof. Think of it as evidence 
(proof ) that what you put into your digital file will all come out 
on the printed page exactly as you intend: the right fonts, graph-
ics, colors, margins, and overall positioning.

Print Proofing

Print Proof

Using It Wisely
Printing proofs are used for checking that 
all text and graphics and colors come out as 
expected before going to press. It is a good 
practice to print a proof from your desktop 
printer and send along with your digital files 
to your service bureau or commercial printer. 
They can be black and white or in color but 
a good PostScript laser proof is ideal. If the 
file won’t print properly to a desktop printer, 
chances 

are it won’t come out on the printer press 
correctly either. Proofing your work comes at 
various stages but there are specific types of 
proofs created during prepress and printing 
that allow the designer to see if their piece 
will come out as intended in the final printing. 
Different types of printing proofs are more 
accurate than others but with increased 
accuracy comes increased costs.

Full-Color Make sure your files are in CMYK format 
only. Do not use RGB or any other color systems as they 
don’t give an accurate representation of what will print.

Spot-Colors Make sure to specify all Spot 
Colors. Choose colors from Pantone matching 
system. Files must be setup with appropriate colors 
in order to separate correctly..

Fonts Make sure all fonts are either embedded 
or sent with the file.

Trim-Area All borders, text and important 
images are 1/4” away from the edge of trim size.

Lines Keep lines (rules) more than .5 (1/2pt). If 
they are less than .5, they might not print.  

Resolution Make sure all images are 300dpi or 
350dpi in order to produce the highest quality result. 
Although 72dpi may look acceptable on your monitor, it will 
result in poor image quality on printed products.

Bleeds If you want any of your printed pieces to 
print to the edge of the paper (BLEED), make sure 
you provide a 1/8” of extra image all around.

Rich-Black (C-65 M-53 Y- 51 K-100) should be 
applied to large areas of black. Applying this code will 
ensure a consistent dense color when printed. Please 
be aware of the percentages of colors in that black 
color area. 

Spell-Check Make sure you use spell check 
and grammar check throughout your piece before 
submitting the final copy. While most printing 
companies have their prep department review every 
file, they cannot guarantee all errors will be caught.

PROOFING
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Some types of printing proofs include blueline, Velox, Matchprint, color laser, and inkjet. Other general types of proofs are 
hard proofs (printed) and soft proofs (on-screen only), galley, reader, or imposition proofs (for checking general layout, order 
of pages, alignment, etc.) and contract proofs - the final proof (of whatever type) that the printer relies on to print the job.

A prepress proof is an analog or digital proof that uses 
inkjet, toner, dyes, overlays, photographic, film, or other 
techniques to give a close approximation of what the finished 
piece will look like. Unlike a press proof, the prepress 
proof does not use the actual printing inks therefore color 
proofs may not be quite as accurate as a press proof.

A press proof is a proof from the printing press, plates, and actual inks specified for 
the job. A press proof is used to verify images, tone values, colors, and imposition. 
Because it involves setting up the job and running a proof on the actual paper to be 
used, it is normally done with the designer on-site (and sometimes your customer as 
well). It’s your last chance to get it right and can add additional cost to the job.

Usually inexpensive, photographic 
proof from negatives where all colors 
are shown in blue (or another color) is 
called a blueline. The negatives used 
for the printing plates are exposed to 
a photosensitive paper to produce the 
image on the blueline. A blueline is a type 
of contact proof, so named because it is 
created by having the negative come in 
contact with a special type of paper.

Blueline Proof Velox ProofMatchprint Proof

Velox is a high contrast black and 
white paper used for print or proof 
purposes. When used generically 
Velox commonly refers to a positive 
photographic print made from a screen 
negative printed from a high-resolution 
imagesetter onto any resin coated paper. 

One of the more expensive but more 
accurate types of prepress proofs 
is the Matchprint. Although used 
generically to refer to any laminate 
analog color proof system, Matchprint 
is actually a brandname of both analog 
and digital proofing systems.

By the time you get to a press check, typos should be fixed, and 
layout, font, and image choices finalized. Use the press proof or press 
check to confirm paper and ink colors and their interaction. Check for 
registration, page to page color printing / color consistency and the overall 
appearance of the type and the absence of stray marks or hickies.

! BEFORE PRINTING:

PROOFING
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Digital vs. Manual
Just as digital imaging has revolutionized 
graphic design, so too has it made its mark 
on the imposition process. Prior to the use 
of digital imposition, the process used to be 
done manually on photographic film. The film 
then had to be assembled by hand in the 
correct order and placement for printing. 
Using digital imposition via desktop 
computers greatly decreases the turn 
around time and is favored by prepress 
departments now. It’s also more precise 
and decreases the possibility of errors that 
could result in having to reprint the job.

Imposition 
IMPOSITION & PLANNING

The main function of imposition is to ensure that pages are 
printed efficiently and correctly. Though final imposition 
occurs once completed page layouts have passed the pre 
flighting stage, it is important to consider the final product’s 
format, size, colors, and paper. Some basic forethought of 
imposition during the design stage will also save time later on. 

For a designer, working out an imposition visually can 
be very beneficial. You may catch flaws in the layout, 
find more effective ways to print the project, and allow 
for the use of spot colors and special varnishes while 
keeping to a budget. Understanding effective imposition 
will also help you communicate with the printer. 

The illustration shown here demonstrates the process that 
the designer should take into consideration when preparing 
printer spreads for prepress. This is a visual aid you could 
use to help you get an idea of how complex imposition 
can get when considering folds and binding methods. It’s 
always a good idea to create a dummy version of your 
composition before printing the final finished version. 

There are software programs available today that will 
automatically arrange your document correctly. Most 
corporate printing presses will have a knowledgeable 
staff member in place to take care of imposition for 
you. Small shops usually expect the designer to figure 
out the printer spread of his or her document layout. 
If you are ever in doubt, search the internet, ask a 
printing press specialist, or your school professor.

What Is Imposition?

Printer spreads vs Reader spreads
Module A Module B

Back
Cover
Page 8

Front
Cover
Page 1

Page 2 Page 7

Page 6 Page 3

Page 4 Page 5

Back
Front
Cover
Page 1

Page 2 Page 3

Page 4 Page 5

Back
Cover
Page 6

Blank

Imposition At A Glance
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Reader spread refers to 
the order of pages as they 
actually appear after pages 
have been folded and 
bound. Refer to Module B.

Printer spread refers to 
the order of pages as 

they actually appear on 
paper for printing. 
Refer to Module A
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Words To Know
color fall: pages marked in an 

imposition plan for special colors and 
different paper selections 

crossover: design, image, or text 
that extends across facing pages 

dummy: miniature prototype of the 
product 

flatplan: layout sketch of pages and 
elements on each page 

imposition: the planning and 
arrangement of pages as they will be 
printed before being cut, folded, and 
assembled 

imposition plan: diagram of all 
pages in a publication indicating the 
layout; can also be used to show the 
paper choices, special colors, etc. 

pagination: sequence of pages in a  
publication 

paper-creep allowance: shifting 
margins slightly so they remain 
consistent after sheets are trimmed and 
assembled at the spine of a thick saddle-
stitched book

printing pass: sheet’s movement 
through the printing press 

PRINTER SPREAD: the order of pages 
as they actually appear on paper for 
printing

READER SPREAD: Reader spreads  the 
order of pages as they actually appear 
after pages have been folded and bound

signature: section of 16 pages in a 
publication 

Questions for Planning Imposition
1.	 What kind of paper stock will it be printed on? 

2.	 What is the size of the sheets used and how 
many pages can be printed on each sheet?

3.	 Will double-sided printing be needed? 

4.	 How is it going to be cut, folded and/or trimmed? 

5.	 What type of binding will be used? 

6.	 Will a paper-creep allowance be needed 
to ensure margins are consistent? 

7.	 Will spot colors or spot UV be used?

Planning
IMPOSITION & PLANNING

Prepress must plan press sheets that fold 
into signatures due to creep, which occurs 
when folded signatures jut out unevenly on the 
sides of booklets, magazines, and other such 
publications. It is important to note that the 
binding method effects imposition as much as 
the designer’s folding method. Creep is more 
likely with thick paper, several folds, multiple 
nested signatures positioned within each other.

TIP
It is good practice to make 

dummy copies of the your 
folding and binding methods.

An imposition plan is a basic diagram of each page. 
This can demonstrate pagination, paper types, number 
of signatures, and color fall. Flatplans, sketches showing 
the layout of images and text, can also be used to identify 
potential problems with color usage or crossovers. 

Designers can also benefit from creating a 
smaller version of the publication called a dummy. 
For folded publications in particular, a dummy 
can easily demonstrate which pages will need 
to be printed together and then folded. A folded 
signature will typically be printed as follows:

What Is Planning?

Paper Creep
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Binding
Binding is the term used for the different processes 
that are used to hold together the pages or sections of 
any publication to form a book, magazine, brochure 

or other format. Binding choices have a direct 
influence on the durability, functionality and cost of a 
publication, as well as adding to its visual qualities.

Screw and Post
 Screw and post binding 
accommodates wide range and 
variety of materials. This method 
allows the user to remove and replace 
pages by removing the screws.

Perfect Binding Burst Perfect

Self Binds

Case Binding
A durable method often used in the 
production of hardback books.

Perfect, or unsewn, binding is a 
method that is commonly used for 
magazines and paperback books.

For this binding method 
signatures are sewn, then glued 
as with perfect binding

Such publications are  described as self binds because 
the reader manually rebinds the publication after 

uing it by folding it again. Maps and brochures are 
typical examples of self binds.

4 Page 6 Page 6 Page Accordion 8 Page French Fold

8 Page Parallel8 Page Map Fold

8 Page Accordion

8 Page Gate Fold 10 Page Reverse Map Fold 12 Page Broadside

Saddle Stitching
Binding method that fastens the 
loose pages of a publication with wire 
stitches through the central fold.   

Side Stitching
Uses wire stitches to secure pages 
through the entire thickness of the text 
block to give additional strength.
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Case Binding
Case-bindings are the common bindings for 
hardcover books. The pages are arranged in 
signatures, sewn together, and attached to a hard 

cover. The covers of case bound books can be made 
from many different
materials such as leather, vinyl or cloth.  
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1

2

3

7

8

10

Hinge

Backing Paper

Signature

4Cover

5Cover Board

6Page

Headband

Crash

9 Head

End Sheet

11Cover Material

12 Face

13 Flyleaf

14 Foot

Insert 15

BOOK BINDING

Case binding can also be referred to as edition bind-
ing or case bound. This type of  binding is also the 

most used type of  binding for a book. It’s mostly 
commonly used because of  its sturdy assembly. 
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Postal Regulations

Direct mail remains one of the most powerful marketing 
vehicles for businesses large and small. In fact, 78 percent 
of small businesses rely on print communications and 
direct mail to communicate with their target audiences. 
The challenge is to design your mailing for consumer 
impact and Postal Service™ approval. If you are not 
an expert in USPS mailing regulations, look inside for 
some helpful hints that can save you time and money.

When designing direct mail, postcards, or other 
materials that will be mailed, it is important to consider 
the postal regulations for a particular piece. Paper choice, 
thickness, and glossiness is also something to think 
about. Knowing postal regulations can help you design 
a mail piece in a way that will prevent wear and tear.
• Need to know the mailing guidelines for postcards?
• Want to know if you need a protective 

coating on your artwork?
• Is your paper choice too thick for postal machines?

Knowing where the file will be 
printed before starting any design is 
highly important, since it will affect 
what colors you can & can’t use

Mailing Standards of the United 
States Postal Service
Domestic Mail Manual

PRINT MORE. PAY LESS.
When you plan ahead, you’ll be thrilled 
with how much you can save.

 YELLOW ZONE - No addresses with a Zip Code & 
State. This will eliminate the risk of your postcards being 
returned to you by the Postal automation process. If 
necessary, an address can be placed in this area if it does 
not contain a state or zip code. The Post Office will scan 
this entire area for recipient addresses and zip codes.

 RED ZONE - No text/graphics greater than 7% 
grayscale. The only text allowed in the addressing area is 
the recipient mailing address. We recommend following 
this guide if you are designing your own card. If you 
are mailing your cards, this guide must be followed.

Brochure Standard
Greeting Card
Triple Standard

Deluxe
Double Deluxe
Triple Deluxe

Sumo®
Double Sumo®
Triple Sumosm

5” x 7”
Double 5” x 7”
Triple 5” x 7”

POSTAL REGULATIONS

Consult your Print facility early in the design stage 
of your project. Making design changes late can be 
painfully expensive.  
The experts can help you with:

• paper choices 
• color options 
• size and format of mailer 
• setting design parameters for postal discounts

For more information on smart designing, 
or answers to other printing questions, contact 
your staff of experts at your local print shop.

Check out the U.S. Postal Service™ Web site, 
www.usps.com, for detailed information on mailing 
services. You can also consult the Domestic Mail 
Manual and other U.S. Postal Service™ publications 
available at your local branch post office.

http://pe.usps.com/text/dmm300/dmm300_landing.htm

modernpostcard.com

Design vs Postal Regulations

!
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Designing for Postal Regulations

You can and should change 
your color settings for all adobe 
products within the creative Suite 
color settings box of adobe Bridge, 
which is under the edit menu.

CAREFULLY WEIGH YOUR OPTIONS.
Everyone loves to save money, but don’t 
sacrifice quality and impact for a few dollars.

POSTAL REGULATIONS

To make every dollar count, you need to begin 
considering costs at the concept stage of a print 
project. Here are several suggestions:

• Designing an unusual format usually results in running 
up unusual costs. A brochure with non- standard dimensions 
may require an expensive custom-made envelope. There is 
a clear advantage to working with standard paper sizes.

• Avoid using bleeds (when the ink goes off the edge 
of the paper without leaving a border). This can add 
five to ten percent to the cost of your printing order.

• Carefully weigh the value of your choices. For instance, 
limiting yourself to black ink on white paper will save 
money. But adding one or two colors can create impact 
and interest that more than offset the modest cost.

• Consider ways to design and prepare your 
direct mail that can reduce postage costs.

To avoid paying extra charges, design your mailing 
to fit within the size specifications laid out by the 
USPS. Postcards, letters and flats all have standard 
dimensions that need to be adhered to. Response cards 
and envelopes also have precise specifications.

All nonprofits qualify for the same postal discounts 
available to regular organizations and businesses. 
However, certain nonprofits are authorized by the 
U.S. Postal Service™ to receive additional savings 
on postage rates. Usage of nonprofit rates depends 
both on the organization’s eligibility and whether 
the content of the mailing meets federal statutes.
To qualify for low nonprofit rates, an organization 

must submit Form 3624 to the USPS and 
fit into one of these eight categories:

Keep in mind that the U.S. Postal Service™ wants you to 
prepare your mail for automated processing so that your 
mail is delivered quickly and accurately. To that end, design, 
packaging, preparation, bar coding and presorting are all 
key factors. To receive an automated mail discount, every 
piece in your flat mailing must be 100 percent automated.
The post office also gives significant discounts for drop 

shipping to a bulk mailing center or a sectional center facility.

Designing for Production

Save Money with Design

Check your Specs

• Agricultural 
• Philanthropic 
• Educational 
• Labor

• Scientific 
• Veterans 
• Religious 
• Fraternal

allegranetwork.com
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Additive_Color Color produced by 
light falling onto a surface, as compared to 
subtractive color. The additive primary colors 
are red, green and blue.

Against_the_Grain At right angles to the 
grain direction of the paper being used, as 
compared to with the grain. Also called across 
the grain and cross grain. See also Grain 
Direction.

Aqueous_Coating Coating in a water 
base and applied like ink by a printing press to 
protect and enhance the printing underneath.

Back_Up (1) To print on the second side of a 
sheet already printed on one side. (2) To adjust 
an image on one side of a sheet so that it aligns 
back-to-back with an image on the other side.

Basis_Weight In the United States and 
Canada, the weight, in pounds, of a ream (500 
sheets) of paper cut to the basic size. Also called 
ream weight and substance weight (sub weight). 
In countries using ISO paper sizes, the weight, 
in grams, of one square meter of paper. Also 
called grammage and ream weight.

Bible_Paper Very thin, opaque paper used for 
products such as bibles and dictionaries. Also 
called India paper.

Bind Usually in the book arena, but not 
exclusively, the joining of leafs or signatures 
together with either wire, glue or other means.

Blanket Rubber-coated pad, mounted on 
a cylinder of an offset press, that receives the 
inked image from the plate and transfers it to 
the surface to be printed.

Bleed Printing that extends to the edge of a 
sheet or page after trimming.

Blind_Image Image debossed, embossed or 
stamped, but not printed with ink or foil.

Blueline Prepress proof made where all colors 
show as blue images on white paper. “Blueline” 
is a generic term for proofs made from a variety 
of materials having similar appearances that 
may also be called position proof, silverprint, 
Dylux, and VanDyke.

Bronzing The effect produced by dusting wet 
ink after printing and using a metallic powder.

Build-a-Color To overlap two or more 
screen tints to create a new color. Such an 
overlap is called a build, color build, stacked 
screen build or tint build.

Bulk Thickness of paper relative to its basic 
weight.

Burn To expose a printing plate to light.

Burst-Perfect-Bind To bind by forcing 
glue into notches along the spines of gathered 
signatures before affixing a paper cover. Also 
called burst bind, notch bind and slotted bind.

Buy_Out To subcontract for a service 
Calender To make the surface of paper 
smooth by pressing it between rollers during 
manufacturing.

Caliper (1) Thickness of paper or other 
substrate expressed in thousandths of an 
inch (mils or points), pages per inch (ppi), 
thousandths of a millimeter (microns) or pages 
per centimeter (ppc). (2) Device on a sheetfed 
press that detects double sheets or on a binding 
machine that detects missing signatures or 
inserts.

Camera-ready_Copy Mechanicals, 
photographs and art fully prepared for 
reproduction according to the technical 
requirements of the printing process being 
used. Also called finished art and reproduction 
copy.

Carbonless_Paper Paper coated with 
chemicals that enable transfer of images from 
one sheet to another with pressure from writing 
or typing.

Chalking Deterioration of a printed image 
caused by ink that absorbs into paper too fast 
or has long exposure to sun, and wind making 
printed images look dusty. Also called crocking.

Choke Technique of slightly reducing the 
size of an image to create a hairline trap or to 
outline. Also called shrink and skinny.

Chroma Strength of a color as compared to 
how close it seems to neutral gray. Also called 
depth, intensity, purity and saturation.

CMYK Abbreviation for cyan, magenta, yellow 
and key (black), the four process colors.

Coated_Paper Paper with a coating of clay 
and other substances that improves reflectivity 
and ink holdout. Mills produce coated paper in 
the four major categories cast, gloss, dull and 
matte.

Collate To organize printed matter in a 
specific order as requested.

Collating_Marks Mostly in the book 
arena, specific marks on the back of signatures 

indicating exact position in the collating stage.

Color_Balance Refers to amounts of 
process colors that simulate the colors of the 
original scene or photograph.

Color_Break In multicolor printing, the 
point, line or space at which one ink color stops 
and another begins.

Color_Cast Unwanted color affecting an 
entire image or portion of an image.

Color_Control_Bar Strip of small blocks 
of color on a proof or press sheet to help 
evaluate features such as density and dot gain. 
Also called color bar, color guide and standard 
offset color bar.

Color_Correct To adjust the relationship 
among the process colors to achieve desirable 
colors.

Color_Curves Instructions in computer 
software that allow users to change or correct 
colors. Also called HLS and HVS tables.

Color_Gamut The entire range of hues 
possible to reproduce using a specific device, 
such as a computer screen, or system, such as 
four-color process printing.

Color_Separation (1) Technique of using 
a camera, scanner or computer to divide 
continuous-tone color images into four halftone 
negatives. (2) The product resulting from color 
separating and subsequent four-color process 
printing. 

Color_Sequence Order in which inks are 
printed. With process colors, the sheetfed 
sequence is often black first, then magenta, 
cyan, and yellow last. The web sequence is 
often cyan, magenta, yellow, and black either 
first or last. Also called letdown sequence and 
rotation.

Color_Shift Change in image color resulting 
from changes in register, ink densities or dot 
gain during four-color process printing.

Comb_Bind To bind by inserting the teeth of 
a flexible plastic comb through holes punched 
along the edge of a stack of paper. Also called 
plastic bind and GBC bind (a brand name).

Commercial_Printer Printer producing a 
wide range of products such as announcements, 
brochures, posters, booklets, stationery, 
business forms, books and magazines. Also 
called job printer because each job is different.
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Composite_Proof Proof of color separations 
in position with graphics and type. Also called 
final proof, imposition proof and stripping 
proof.

Condition To keep paper in the pressroom 
for a few hours or days before printing so that 
its moisture level and temperature equal that 
in the pressroom. Also called cure, mature and 
season.

Continuous-tone_Copy All photographs 
and those illustrations having a range of shades 
not made up of dots, as compared to line copy 
or halftones. Abbreviated contone.

Converter Business that makes products such 
as boxes, bags, envelopes and displays.

Cover_Paper Category of thick paper used 
for products such as posters, menus, folders and 
covers of paperback books.

Crash Coarse cloth embedded in the glue 
along the spine of a book to increase strength 
of binding. Also called gauze, mull and scrim.

Creep Phenomenon of middle pages of a folded 
signature extending slightly beyond outside 
pages. Also called feathering, outpush, push 
out and thrust. 

Crop_Marks Lines near the edges of an 
image indicating portions to be reproduced. 
Also called cut marks and tic marks.

Crossover Type or art that continues from 
one page of a book or magazine across the 
gutter to the opposite page. Also called bridge, 
gutter bleed and gutter jump.

Cure To dry inks, varnishes or other coatings 
after printing to ensure good adhesion and 
prevent setoff.

Deboss To press an image into paper so it lies 
below the surface.

Deckle_Edge Edge of paper left ragged as it 
comes from the papermaking machine instead 
of being cleanly cut. Also called feather edge.

Density (1) Regarding ink, the relative 
thickness of a layer of printed ink. (2) 
Regarding color, the relative ability of a color 
to absorb light reflected from it or block light 
passing through it. (3) Regarding paper, the 
relative tightness or looseness of fibers.

Device_Independent_Colors Hues 
identified by wavelength or by their place in 

systems such as developed by CIE. ‘Device 
independent’ means a color can be described 
and specified without regard to whether 
it is reproduced using ink, projected light, 
photographic chemistry or any other method.

Die_Cut To cut irregular shapes in paper or 
paperboard using a die.

Dot_Gain Phenomenon of halftone dots 
printing larger on paper than they are on 
films or plates, reducing detail and lowering 
contrast. Also called dot growth, dot spread 
and press gain.

Dots-per-inch Measure of resolution of 
input devices such as scanners, display devices 
such as monitors, and output devices such 
as laser printers, imagesetters and monitors. 
Abbreviated DPI. Also called dot pitch.

Double_Black_Duotone Duotone printed 
from two halftones, one shot for highlights and 
the other shot for midtones and shadows.

Double_Bump To print a single image twice 
so it has two layers of ink.

Doubling Printing defect appearing as 
blurring or shadowing of the image. Doubling 
may be caused by problems with paper, 
cylinder alignment, blanket pressures or dirty 
cylinders.

DPI Considered as “dots per square inch,” a 
measure of output resolution in relationship to 
printers, imagesetters and monitors.

Drawdown Sample of inks specified for a job 
applied to the substrate specified for a job. Also 
called pulldown.

Dropout Halftone dots or fine lines 
eliminated from highlights by overexposure 
during camera work. The lost copy is said to 
have dropped out.

Duotone Black-and-white photograph 
reproduced using two halftone negatives, each 
shot to emphasize different tonal values in the 
original.

Emboss To press an image into paper so it lies 
above the surface. Also called cameo and tool.

Emulsion Casting of light-sensitive chemicals 
on papers, films, printing plates and stencils.

Emulsion_Down/Up Film whose emulsion 
side faces down (away from the viewer) or up 
(toward the viewer) when ready to make a plate 

or stencil. Abbreviated ED, EU. 

Engraving Printing method using a plate, 
also called a die, with an image cut into its 
surface.

EPS Encapsulated Post Script, a known file 
format usually used to transfer post script 
information from one program to another.

Equivalent_Paper Paper that is not the 
brand specified, but looks, prints and may cost 
the same. . Also called comparable stock.

Estimate Price that states what a job will 
probably cost. Also called bid, quotation and 
tender.

Etch To use chemicals to carve an image into 
metal, glass or film.

Fixed_Costs Costs that remain the same 
regardless of how many pieces are printed. 
Copyrighting, photography and design are 
fixed costs.

Flat_Color (1) Any color created by printing 
only one ink, as compared to a color created by 
printing four-color process. Also called block 
color and spot color. (2) color that seems weak 
or lifeless.

Flat Stripped film ready for platemaking.

Flexography Method of printing on a web 
press using rubber or plastic plates with raised 
images. Also called aniline printing because 
flexographic inks originally used aniline dyes. 
Abbreviated flex.

Flood To print a sheet completely with an 
ink or varnish. flooding with ink is also called 
painting the sheet.

Foil_Stamp Method of printing that releases 
foil from its backing when stamped with the 
heated die. Also called block print, hot foil 
stamp and stamp.

For_Position_Only Refers to inexpensive 
copies of photos or art used on mechanical 
to indicate placement and scaling, but not 
intended for reproduction. Abbreviated FPO.

Fountain_Solution Mixture of water 
and chemicals that dampens a printing plate 
to prevent ink from adhering to the nonimage 
area. Also called dampener solution.

Fo ur - co lo r _ Pro c ess _ Prin  t in  g 
Technique of printing that uses black, magenta, 
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cyan and yellow to simulate full-color images. 
Also called color process printing, full color 
printing and process printing.

Free_Sheet Paper made from cooked wood 
fibers mixed with chemicals and washed free of 
impurities, as compared to groundwood paper. 
Also called woodfree paper.

Gang (1) To halftone or separate more 
than one image in only one exposure. (2) 
To reproduce two or more different printed 
products simultaneously on one sheet of paper 
during one press run. Also called combination 
run.

Gathered Signatures assembled next to each 
other in the proper sequence for binding, as 
compared to nested. Also called stacked.

Graduated_Screen_Tint Screen tint that 
changes densities gradually and smoothly, not 
in distinct steps. Also called degrade, gradient, 
ramped screen and vignette.

Grain_Direction Predominant direction in 
which fibers in paper become aligned during 
manufacturing. Also called machine direction.

Grain_Long/Short_Paper Paper whose 
fibers run parallel to the long/short dimension 
of the sheet. 

Gravure Method of printing using metal 
cylinders etched with millions of tiny wells that 
hold ink.

Gray_Balance Printed cyan, magenta and 
yellow halftone dots that accurately, reproduce 
a neutral gray image.

Gra y_Component_ Replac ement 
Technique of replacing gray tones in the 
yellow, cyan and magenta films, made while 
color separating, with black ink. Abbreviated 
GCR. Also called achromatic color removal.

Gray_Levels Number of distinct gray tones 
that can be reproduced by a computer.

Gripper_Edge Edge of a sheet held by 
grippers on a sheetfed press, thus going first 
through the press. Also called feeding edge and 
leading edge.

GSM The unit of measurement for paper weight 
(grams per square meter).

Gutter In the book arena, the inside margins 
toward the back or the binding edges.

Hairline Subjective term referring to very 
small space, thin line or close register.

Halftone (1) To photograph or scan a 
continuous tone image to convert the image 
into halftone dots. (2) A photograph or 
continuous-tone illustration that has been 
halftoned and appears on film, paper, printing 
plate or the final printed product.

Heat-set_Web Web press equipped with an 
oven to dry ink, thus able to print coated paper.

Hickey Spot or imperfection in printing, most 
visible in areas of heavy ink coverage, caused 
by dirt on the plate or blanket. Also called bulls 
eye and fish eye.

House_Sheet Paper kept in stock by a printer 
and suitable for a variety of printing jobs. Also 
called floor sheet.

Imagesetter Laser output device using 
photosensitive paper or film.

Image_Trap Slight overlapping of images to 
ensure they appear registered.

Imposition Arrangement of pages on 
mechanicals or flats so they will appear in 
proper sequence after press sheets are folded 
and bound.

Impression (1) Referring to an ink color, one 
impression equals one press sheet passing once 
through a printing unit. (2) Referring to speed 
of a press, one impression equals one press 
sheet passing once through the press.

Impression_Cylinder Cylinder, on a press, 
that pushes paper against the plate or blanket, 
thus forming the image. Also called impression 
roller.

Imprint To print new copy on a previously 
printed sheet, such as imprinting an employee’s 
name on business cards. Also called surprint.

Ink_Balance Relationship of the densities 
and dot gains of process inks to each other and 
to a standard density of neutral gray.

Ink_Fountain Reservoir, on a printing press, 
that holds ink.

Ink_Holdout Characteristic of paper that 
prevents it from absorbing ink, thus allowing 
ink to dry on the surface of the paper. Also 
called holdout.

Ink_Jet_Printing Method of printing by 
spraying droplets of ink through computer-
controlled nozzles. 

Ink_Trap Ink printed over a previously 
printed image.

Job_Ticket Form used by service bureaus, 
separators and printers to specify production 
schedule of a job and the materials it needs. 
Also called docket, production order and work 
order.

Keylines Lines on a mechanical or negative 
showing the exact size, shape and location of 
photographs or other graphic elements. Also 
called holding lines.

Lay-Flat_Bind Method of perfect binding that 
allows a publication to lie fully open. 

Letterpress Method of printing from raised 
surfaces, either metal type or plates whose 
surfaces have been etched away from image 
areas. Also called block printing.

Lithography Method of printing using 
plates whose image areas attract ink and whose 
nonimage areas repel ink. Nonimage areas 
may be coated with water to repel the oily ink 
or may have a surface, such as silicon, that 
repels ink.

M_Weight Weight of 1,000 sheets of paper in 
any specific size.

Makeready (1) All activities required to 
prepare a press or other machine to function for 
a specific printing or bindery job, as compared 
to production run. Also called setup. (2) Paper 
used in the makeready process at any stage in 
production. Makeready paper is part of waste 
or spoilage.

Mask To prevent light from reaching part of an 
image, therefore isolating the remaining part. 
Also called knock out.

Match_Print A form of a four-color-process 
proofing system.

Mechanical_Camera-ready assembly of 
type, graphic and other copy complete with 
instructions to the printer. Also called an 
artboard and pasteup.

Mock_Up A reproduction of the original 
printed matter and possibly containing 
instructions or direction.

Moire Undesirable pattern resulting when 
halftones and screen tints are made with 
improperly aligned screens, or when a pattern 
in a photo, such as a plaid, interfaces with a 
halftone dot pattern.

Nested_Signatures assembled inside one 
another in the proper sequence for binding, as 
compared to gathered. Also called inset.

Non-Heatset_Web Web press without a de
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drying oven, thus not able to print on coated 
paper. Also called cold-set web and open web.

Nonimpact-Printing Printing using lasers, 
ions, ink jets or heat to transfer images to paper.

Offset_Printing Printing technique that 
transfers ink from a plate to a blanket to paper 
instead of directly from plate to paper.

Opacity (1) Characteristic of paper or other 
substrate that prevents printing on one side 
from showing through the other side. (2) 
Characteristic of ink that prevents the substrate 
from showing through.

Onion_Skin A specific lightweight type 
(kind) of paper usually used in the past for air 
mail. Seldom used today (in the typewriter era).

Overlay_Proof Color proof consisting of 
polyester sheets laid on top of each other with 
their image in register, as compared to integral 
proof. Each sheet represents the image to be 
printed in one color. Also called celluloid proof 
and layered proof.

Page_Proof Proof of type and graphics as 
they will look on the finished page complete 
with elements such as headings, rules and 
folios.

Pagination In the book arena, the 
numbering of pages.

Painted_Sheet Sheet printed with ink edge to 
edge, as compared to spot color. The painted 
sheet refers to the final product, not the press 
sheet, and means that 100 percent coverage 
results from bleeds off all four sides.

Paste-up To paste copy to mounting boards 
and, if necessary, to overlays so it is assembled 
into a camera-ready mechanical. The 
mechanical produced is often called a paste-up.

Perfect_Bind To bind sheets that have been 
ground at the spine and are held to the cover by 
glue. Also called adhesive bind, cut-back bind, 
glue bind, paper bind, patent bind, perfecting 
bind, soft bind and soft cover. See also Burst 
Perfect Bind.

Perfecting_Press Press capable of printing 
both sides of the paper during a single pass. 
Also called duplex press and perfector.

Perforating Taking place on a press or a 
binder machine, creating a line of small dotted 
wholes for the purpose of tearing-off a part of 
a printed matter (usually straight lines, vertical 
or horizontal).

Pin_Register Technique of registering 

separations, flats and printing plates by using 
small holes, all of equal diameter, at the edges 
of both flats and plates.

Plate Piece of paper, metal, plastic or rubber 
carrying an image to be reproduced using a 
printing press.

Plate-ready_Film Stripped negatives or 
positives fully prepared for platemaking.

Pleasing_Color Color that the customer 
considers satisfactory even though it may not 
precisely match original samples, scenes or 
objects.

PMS Obsolete reference to Pantone Matching 
System. The correct trade name of the colors 
in the Pantone Matching System is Pantone 
colors, not PMS Colors.

Post_Bind To bind using a screw and post 
inserted through a hole in a pile of loose sheets.

Prepress Camera work, color separations, 
stripping, platemaking and other prepress 
functions performed by the printer, separator 
or a service bureau prior to printing. Also 
called preparation.

Press_Proof Proof made on press using the 
plates, ink and paper specified for the job. Also 
called strike off and trial proof.

Printer_Spreads Mechanicals made so 
they are imposed for printing, as compared to 
reader spreads.

Printing_Unit Assembly of fountain, rollers 
and cylinders that will print one ink color. Also 
called color station, deck, ink station, printer, 
station and tower.

Process_Colors The colors used for four-
color process printing: yellow, magenta, cyan 
and black.

Proof Test sheet made to reveal errors or 
flaws, predict results on press and record how 
a printing job is intended to appear when 
finished.

Quick_Printing Printing using small 
sheetfed presses, called duplicators, using cut 
sizes of bond and offset paper.

Rag_Paper Stationery or other forms of stock 
having a strong percentage content of “cotton 
rags.”

Rainbow_Fountain Technique of putting 
ink colors next to each other in the same ink 
fountain and oscillating the ink rollers to make 
the colors merge where they touch, producing a 
rainbow effect.

Raster_Image_Processor Device that 
translates page description commands into 
bitmapped information for an output device 
such as a laser printer or imagesetter.

Reader_Spread Mechanicals made in two 
page spreads as readers would see the pages, as 
compared to printer spread.

Ream 500 sheets of paper.

Reflective_Copy Products, such as fabrics, 
illustrations and photographic prints, viewed 
by light reflected from them, as compared to 
transparent copy. Also called reflex copy.

Register_Marks Cross-hair lines on 
mechanicals and film that help keep flats, 
plates, and printing in register. Also called 
crossmarks and position marks.

Relief_Printing Printing method whose 
image carriers are surfaces with two levels 
having inked areas higher than noninked 
areas. Relief printing includes block printing, 
flexography and letter press.

Repeatability Ability of a device, such as an 
imagesetter, to produce film or plates that yield 
images in register.

Reprographics General term for 
xerography, diazo and other methods of 
copying used by designers, engineers, architects 
or for general office use.

Reverse Type, graphic or illustration 
reproduced by printing ink around its outline, 
thus allowing the underlying color or paper to 
show through and form the image. The image 
‘reverses out’ of the ink color. Also called 
knockout.

RGB Abbreviation for red, green, blue, the 
additive color primaries.

Right_Reading Copy that reads correctly 
in the language in which it is written. Also 
describes a photo whose orientation looks like 
the original scene, as compared to a flopped 
image.

Round_Back_Bind To case bind with a 
rounded (convex) spine, as compared to flat 
back bind.

Saddle_Stitch To bind by stapling sheets 
together where they fold at the spine, as 
compared to side stitch. Also called pamphlet 
stitch, saddle wire and stitch bind.

Satin_Finish Alternate term for dull finish on 
coated paper.
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Score To compress paper along a straight line 
so it folds more easily and accurately. Also 
called crease.

Screen_Angles Angles at which screens 
intersect with the horizontal line of the 
press sheet. The common screen angles for 
separations are black 45 degree, magenta 75 
degree, yellow 90 degree and cyan 105 degree.

Screen_Density Refers to the percentage of 
ink coverage that a screen tint allows to print 
(dot area). Also called screen percentage.

Screen_Printing Method of printing by 
using a squeegee to force ink through an 
assembly of mesh fabric and a stencil.

Screen_Ruling Number of rows or lines 
of dots per inch or centimeter in a screen for 
making a screen tint or halftone. Also called 
line count, ruling, screen frequency, screen size 
and screen value.

Screen_Tint Color created by dots instead 
of solid ink coverage. Also called Benday, fill 
pattern, screen tone, shading, tint and tone.

Self_Mailer A printed item independent of an 
envelope. A printed item capable of travel in 
the mailing arena independently.

Sheetfed_Press Press that prints sheets of 
paper, as compared to a web press.

Sheetwise Technique of printing one side of a 
sheet with one set of plates, then the other side 
of the sheet with a set of different plates. Also 
called work and back.

Shingling Allowance, made during paste-up 
or stripping, to compensate for creep. Creep 
is the problem; shingling is the solution. Also 
called stair stepping and progressive margins.

Side_stitch To bind by stapling through 
sheets along, one edge, as compared to saddle 
stitch. Also called cleat stitch and side wire.

Signature Printed sheet folded at least once, 
possibly many times, to become part of a book, 
magazine or other publication.

Soy-based_Inks Inks using vegetable oils 
instead of petroleum products as pigment 
vehicles, thus are easier on the environment.

Specular_Highlight Highlight area with 
no printable dots, thus no detail, as compared 
to a diffuse highlight. Also called catchlight 
and dropout highlight.

Spine Back or binding edge of a publication

Spiral_Bind To bind using a spiral of 
continuous wire or plastic looped through 
holes. Also called coil bind.

Split_Fountain Technique of putting ink 
colors next to each other in the same ink 
fountain and printing them off the same plate. 
Split fountains keep edges of colors distinct, 
as compared to rainbow fountains that blend 
edges.

Split_Run (1) Different images, such as 
advertisements, printed in different editions 
of a publication. (2) Printing of a book that has 
some copies bound one way and other copies 
bound another way.

Spoilage Paper that, due to mistakes or 
accidents, must be thrown away instead of 
delivered printed to the customer, as compared 
to waste.

Spot_Color or Varnish One ink or varnish 
applied to portions of a sheet, as compared to 
flood or painted sheet.

Spread (1) Two pages that face each other and 
are designed as one visual or production unit. 
(2) Technique of slightly enlarging the size of 
an image to accomplish a hairline trap with 
another image. Also called fatty.

Step_and_Repeat Prepress technique of 
exposing an image in a precise, multiple 
pattern to create a flat or plate. Images are said 
to be stepped across the film or plate.

Strip To assemble images on film for 
platemaking. Stripping involves correcting 
flaws in film, assembling pieces of film into 
flats and ensuring that film and flats register 
correctly. Also called film assembly and image 
assembly.

Subtractive_Color Color produced by 
light reflected from a surface, as compared to 
additive color. Subtractive color includes hues 
in color photos and colors created by inks on 
paper.

Subtractive_Primary_Color Yellow, 
magenta and cyan. In the graphic arts, these 
are known as process colors because, along 
with black, they are the inks colors used in 
color-process printing.

Supercalendered_Paper Paper calendered 
using alternating chrome and fiber rollers to 
produce a smooth, thin sheet. Abbreviated SC 
paper.

Saddle_Stitch To bind by stapling sheets 
together where they fold at the spine, as 
compared to side stitch. Also called pamphlet 
stitch, saddle wire and stitch bind.

Satin_Finish Alternate term for dull finish on 
coated paper.

Score To compress paper along a straight line 
so it folds more easily and accurately. Also 
called crease.

Screen_Angles Angles at which screens 
intersect with the horizontal line of the 
press sheet. The common screen angles for 
separations are black 45 degree, magenta 75 
degree, yellow 90 degree and cyan 105 degree.

Screen_Density Refers to the percentage of 
ink coverage that a screen tint allows to print 
(dot area). Also called screen percentage.

Screen_Printing Method of printing by 
using a squeegee to force ink through an 
assembly of mesh fabric and a stencil.

Screen_Ruling Number of rows or lines 
of dots per inch or centimeter in a screen for 
making a screen tint or halftone. Also called 
line count, ruling, screen frequency, screen size 
and screen value.

Screen_Tint Color created by dots instead 
of solid ink coverage. Also called Benday, fill 
pattern, screen tone, shading, tint and tone.

Self_Mailer A printed item independent of an 
envelope. A printed item capable of travel in 
the mailing arena independently.

Sheetfed_Press Press that prints sheets of 
paper, as compared to a web press.

Sheetwise Technique of printing one side of a 
sheet with one set of plates, then the other side 
of the sheet with a set of different plates. Also 
called work and back.

Shingling Allowance, made during paste-up 
or stripping, to compensate for creep. Creep 
is the problem; shingling is the solution. Also 
called stair stepping and progressive margins.

Side_stitch To bind by stapling through 
sheets along, one edge, as compared to saddle 
stitch. Also called cleat stitch and side wire.

Signature Printed sheet folded at least once, 
possibly many times, to become part of a book, 
magazine or other publication.

Soy-based_Inks Inks using vegetable oils 
instead of petroleum products as pigment 
vehicles, thus are easier on the environment.

Specular_Highlight Highlight area with 
no printable dots, thus no detail, as compared 
to a diffuse highlight. Also called catchlight 
and dropout highlight.
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Spine Back or binding edge of a publication

Spiral_Bind To bind using a spiral of 
continuous wire or plastic looped through 
holes. Also called coil bind.

Split_Fountain Technique of putting ink 
colors next to each other in the same ink 
fountain and printing them off the same plate. 
Split fountains keep edges of colors distinct, 
as compared to rainbow fountains that blend 
edges.

Split_Run (1) Different images, such as 
advertisements, printed in different editions 
of a publication. (2) Printing of a book that has 
some copies bound one way and other copies 
bound another way.

Spoilage Paper that, due to mistakes or 
accidents, must be thrown away instead of 
delivered printed to the customer, as compared 
to waste.

Spot_Color or Varnish One ink or varnish 
applied to portions of a sheet, as compared to 
flood or painted sheet.

Spread (1) Two pages that face each other and 
are designed as one visual or production unit. 
(2) Technique of slightly enlarging the size of 
an image to accomplish a hairline trap with 
another image. Also called fatty.

Step_and_Repeat Prepress technique of 
exposing an image in a precise, multiple 
pattern to create a flat or plate. Images are said 
to be stepped across the film or plate.

Strip To assemble images on film for 
platemaking. Stripping involves correcting 
flaws in film, assembling pieces of film into 
flats and ensuring that film and flats register 
correctly. Also called film assembly and image 
assembly.

Subtractive_Color Color produced by 
light reflected from a surface, as compared to 
additive color. Subtractive color includes hues 
in color photos and colors created by inks on 
paper.

Subtractive_Primary_Color Yellow, 
magenta and cyan. In the graphic arts, these 
are known as process colors because, along 
with black, they are the inks colors used in 
color-process printing.

Supercalendered_Paper Paper calendered 
using alternating chrome and fiber rollers to 
produce a smooth, thin sheet. Abbreviated SC 
paper.

Swash_Book A book in a variety of forms, 
indicating specific stock in specific colors in a 
specific thickness.

SWOP Abbreviation for specifications for web 
offset publications, specifications recommended 
for web printing of publications.

Swash_Book A book in a variety of forms, 
indicating specific stock in specific colors in a 
specific thickness.

SWOP Abbreviation for specifications for web 
offset publications, specifications recommended 
for web printing of publications.

Text_Paper Designation for printing papers 
with textured surfaces such as laid or linen. 
Some mills also use ‘text’ to refer to any paper 
they consider top-of-the-line, whether or not its 
surface has a texture.

Thermography Method of printing using 
colorless resin powder that takes on the color of 
underlying ink. Also called raised printing.

Tint Screening or adding white to a solid color 
for results of lightening that specific color.

Tone_Compression Reduction in the 
tonal range from original scene to printed 
reproduction.

Total_Area_Coverage Total of the dot 
percentages of the process colors in the final 
film. Abbreviated for TAC. Also called density 
of tone, maximum density, shadow saturation, 
total dot density and total ink coverage.

Touch_Plate Plate that accents or prints a 
color that four-color process printing cannot 
reproduce well enough or at all. Also called kiss 
plate.

Trap To print one ink over another or to print 
a coating, such as varnish, over an ink. The 
first liquid traps the second liquid. See also Dry 
Traps and Wet Traps.

Uncoated_Paper Paper that has not been 
coated with clay. Also called offset paper.

Undercolor Addition Technique of 
making color separations that increases the 
amount of cyan, magenta or yellow ink in 
shadow areas. Abbreviated UCA.

Undercolor_Removal Technique of 
making color separations such that the amount 
of cyan, magenta and yellow ink is reduced in 
midtone and shadow areas while the amount of 
black is increased. Abbreviated UCR.

Unsharp_Masking Technique of adjusting 
dot size to make a halftone or separation 
appear sharper (in better focus) than the 
original photo or the first proof. Also called 
edge enhancement and peaking.

Up Term to indicate multiple copies of one 
image printed in one impression on a single 
sheet. “Two up” or “three up” means printing 
the identical piece twice or three times on each 
sheet.

UV_Coating Liquid applied to a printed sheet, 
then bonded and cured with ultraviolet light.

Varnish Liquid applied as a coating for 
protection and appearance.

Vellum_Finish Somewhat rough, toothy 
finish.

Vignette Decorative design or illustration 
fade to white.

Virgin_Paper Paper made exclusively of pulp 
from trees or cotton, as compared to recycled 
paper.

Wash-Up To clean ink and fountain solutions 
from rollers, fountains, screens, and other press 
components.

Waste Unusable paper or paper damage 
during normal makeready, printing or binding 
operations, as compared to spoilage.

Watermark Translucent logo in paper 
created during manufacturing by slight 
embossing from a dandy roll while paper is still 
approximately 90 percent water.

Web_Press Press that prints from rolls of 
paper, usually cutting it into sheets after 
printing. Also called reel-fed press.

With_the_Grain Parallel to the grain 
direction of the paper being used, as compared 
to against the grain. See also Grain Direction.

Woodfree Paper Made with chemical pulp 
only. Paper usually classified as calendered or 
supercalendered.

Wove Paper manufactured without visible wire 
marks, usually a fine textured paper.

Wrong_Reading An image that is 
backwards when compared to the original. 
Also called flopped and reverse reading.
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